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Abstract: This study aims to develop interactive PowerPoint-based audio-visual learning media for 

Grade X Economics and to test its feasibility and effectiveness in improving student activity and 

learning outcomes. The method used is Research and Development (R&D) with the ADDIE model, 

which includes the stages of analysis, design, development, implementation, and evaluation. The 

research subjects consisted of students in grades X6 and X7 at SMA N 1 Ngluar and SMA 

Muhammadiyah 1 Muntilan. Data were collected through interviews, questionnaires, and learning 

outcome tests. The feasibility test results showed that the interactive PowerPoint media was considered 

very feasible to use, with an average score of 4.6 from subject matter experts, 4.8 from media experts, 

4.45 from teachers, and 4.5 from students. The effectiveness test showed N-Gain Scores for activity 

and learning outcomes of 0.42 and 0.58, respectively, at SMA N 1 Ngluar and 0.44 and 0.55 at SMA 

Muhammadiyah 1 Muntilan. Thus, interactive PowerPoint media is effective in increasing student 

activity and learning outcomes in economics learning. 

Keywords: Audiovisual Learning; Economics Classes; Interactive Powerpoint; Learning Activity; 

Learning Outcomes 

 

1. Introduction 

The Industry 5.0 era places technology at the center of various aspects of life, including 
education. Education plays an important role in shaping independent and competitive 
individuals in line with the needs of the times (Sudjana, 2020). However, the learning process 
in schools still largely uses conventional teacher-centered methods, so that student activity and 
learning outcomes are not yet optimal. Generation Z, as today's students, are tech-savvy and 
tend to prefer visual and interactive learning (Syah & Hidayatullah, 2023). Therefore, 
technology-based learning media that suits their characteristics is needed. Interactive 
PowerPoint is one effective medium because it can combine text, images, audio, and video, 
thereby encouraging active student engagement (Aini & Listiningsih, 2021). 

Observations at SMA N 1 Ngluar and SMA Muhammadiyah 1 Muntilan show that most 
students have not achieved the Minimum Completion Criteria (KKM) and tend to be passive 
in economics learning. This indicates the need for innovative, engaging, and interactive 
learning media to increase student activity and learning outcomes. Previous studies have 
proven that interactive learning media can increase student motivation and conceptual 
understanding (Arsyad, 2019; Riyana, 2020). Therefore, the development of interactive digital 
PowerPoint-based audiovisual media is expected to be a solution in increasing the activity and 
learning outcomes of 10th grade students in economics. 
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The rapid development of the Industry 5.0 era places technology as the foundation of 
daily human activities, including in the field of education. This era prioritizes the integration 
of digital technology and human-centered innovation to create adaptive and competitive 
generations. Education plays a crucial role in preparing students who are responsive to global 
demands, capable of critical thinking, and ready to compete in the digital era (Sudjana, 2020). 
However, these expectations are often not aligned with learning practices in schools, which 
still tend to adopt conventional approaches. As a result, the learning process becomes less 
interactive, monotonous, and does not fully support students' cognitive and affective 
development. 

In many learning environments, conventional teacher-centered methods still dominate 
classroom interactions. Teachers function as the main providers of knowledge, while students 
become passive recipients who only listen and record information. This condition limits 
opportunities for student participation and creativity. As a consequence, learning outcomes 
tend to stagnate and do not reach the expected competency standards. Passive learning 
behaviors, low motivation, and minimal collaboration indicate that learning methods urgently 
require innovation to support active and meaningful engagement. 

Alongside these challenges, the demographic profile of students needs to be considered. 
Today's learners belong to Generation Z, a generation deeply familiar with technological 
devices and digital platforms. They tend to prefer visual, dynamic, and interactive learning 
approaches (Syah & Hidayatullah, 2023). Traditional delivery methods often fail to capture 
their attention, resulting in boredom and decreased learning enthusiasm. Therefore, the use of 
media that aligns with their characteristics is essential to foster productive and enjoyable 
learning experiences. 

Technology-based learning media have become increasingly utilized to support 
educational innovation. Among them, Interactive PowerPoint emerges as a promising tool 
because it offers flexibility in combining text, images, audio, video, animations, and interactive 
navigation buttons. These features can enhance students' visual comprehension, maintain their 
interest, and improve retention of subject matter (Aini & Listiningsih, 2021). When properly 
designed, interactive PowerPoints can serve not only as presentation slides but also as 
multimedia platforms that stimulate active student engagement. 

Observations conducted at SMA N 1 Ngluar and SMA Muhammadiyah 1 Muntilan 
indicate that students in Grade X Economics classes frequently fail to meet the Minimum 
Completion Criteria (KKM). Additionally, classroom activities show that students are often 
passive, reluctant to ask questions, and hesitant to express opinions. These conditions hinder 
meaningful learning, especially in economics, which requires analytical ability and contextual 
understanding. The lack of engaging learning media further contributes to students’ low 
cognitive outcomes and classroom interaction levels. 

Previous research confirms that the use of interactive and audiovisual media can 
positively influence students’ motivation, conceptual understanding, and learning outcomes. 
Studies by Arsyad (2019) and Riyana (2020) demonstrate that multimedia-based learning 
increases attention spans and helps students better understand abstract concepts. This 
evidence reinforces the need for innovation in teaching media that integrates visual 
stimulation, interactivity, and user control to enhance both learning processes and results. 

Considering these challenges, the development of audiovisual learning media using 
Interactive PowerPoint is expected to provide solutions tailored to the learning needs in 
economics subjects. By utilizing audiovisual elements, this media can support the delivery of 
complex economic concepts in a simpler, more contextual, and more attractive manner. 
Moreover, interactive quizzes, hyperlinks, and navigation features embedded in the media can 
foster two-way communication between students and learning materials, thus improving 
activeness and comprehension 

2. Preliminaries or Related Work or Literature Review 

2.1. Grand Theory 
The use of interactive PowerPoint in economics learning is based on the theories of 

Cognitivism (Piaget & Bruner, 1966), Constructivism (Vygotsky, 1978), Behaviorism (Skinner, 
1957; Pavlov, 1927), Gagné's learning theory (1985), and Educational Technology theory 
(Heinich, Molenda, & Russell, 1993). This medium helps students process information 
(cognitivism), build understanding through interaction (constructivism), increase motivation 
through reinforcement and quizzes (behaviorism), attract attention and provide feedback 
(Gagné), and make learning more interesting and effective (educational technology). 
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2.2 Learning Activity 
Learning activity is the physical and mental involvement of students in the learning 

process (Bariyah, 2022). According to Hamalik (Rizal & Nuriza, 2025), activity is demonstrated 
through student participation in assignments, discussions, questions, and presentations. Thus, 
students play an active role in achieving learning objectives. 
2.3 Student Learning Outcomes 

Learning outcomes are changes in abilities that encompass cognitive, affective, and 
psychomotor aspects as a result of student involvement in the learning process (Herawati, 
2020). According to (Zainuddin & Ubabuddin, 2023), learning outcomes reflect 
improvements in knowledge, attitudes, and skills acquired through learning experiences. Thus, 
learning outcomes can be interpreted as indicators of student success in achieving learning 
objectives through changes in knowledge, attitudes, and behavior. 
2.4 Learning Media 

Learning media are tools or intermediaries for conveying messages from teachers to 
students in order to make learning more effective (Mahardika & Wiranda, 2021; Nurfadhillah, 
2021). According to AECT (in Heinich & Molenda, 2008), media include all forms of means 
of conveying messages. Thus, learning media serve to help teachers transfer knowledge so that 
students can understand the material more easily. 
2.5 Interactive PowerPoint Media 

Interactive PowerPoint is a Microsoft PowerPoint-based learning medium that presents 
material in an engaging and interactive way through text, images, videos, and quizzes 
(Hasanah, 2020). This medium makes it easier for teachers to deliver material and encourages 
students to be more active, thereby increasing engagement and learning outcomes. 
2.6 Economics Education 

Economic education helps students understand how to manage resources to achieve 
prosperity (Sukirno, 2016). According to Kurniawan and Budhi (2015), economics studies 
economic decision-making, while Chien (2022) emphasizes the importance of understanding 
global dynamics. Thus, economic education equips students to think critically and play an 
active role in economic activities. 
2.7 Framework 

This study developed interactive PowerPoint-based audiovisual learning media as an 
innovation to create interesting, active, and effective learning, thereby increasing student 
activity and learning outcomes. 

 
Figure 1. Conceptual Framework 
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3. Materials and Method 

3.1. Development Model 
This study uses the Research and Development (R&D) method with the ADDIE 

(Analysis, Design, Development, Implementation, Evaluation) model (Branch, 2009) because 
it is systematic in developing learning media. The product developed is interactive 
PowerPoint-based audiovisual media on Economic Activities for 10th grade students at 
SMAN 1 Ngluar and SMA Muhammadiyah 1 Muntilan. 

 

 
Source: Branch, (2009) 

Figure 2. ADDIE Development Procedure 
 
3.2. Population and Sample 

The research population consisted of all tenth-grade students in both schools. The 
sample was taken using purposive sampling (Campbell et al., 2020) with the criterion of 
students studying economic activity material. Each school involved two classes, namely class 
X-7 as the experiment (interactive PowerPoint) and class X-6 as the control (regular 
PowerPoint), each with 36 students per class. 
3.3. Data Collection Techniques and Instruments 

In this study, the data collection instruments used were observation, interviews, 
questionnaires, learning outcome tests, and documentation. 

4. Results and Discussion 

4.1. Initial Product Development Results 
This research produced interactive PowerPoint-based audiovisual learning media for 10th 

grade economics classes. Development was carried out using the ADDIE model (Analysis, 
Design, Development, Implementation, Evaluation). 
4.1.1. Analysis Stage 

During the analysis stage, it was found that economics learning still uses conventional 
media, which is not very interesting. Interactive media that combines images, videos, 
animations, and quizzes is needed to make students more active and improve learning 
outcomes. The material is adapted to the Merdeka Curriculum, particularly on the topic of 
Economic Activities, which covers production, distribution, consumption, and the role of 
economic actors in the economic system. The analysis also shows that technological facilities 
in schools are adequate, with most students having digital devices to support learning. 
4.1.2. Design Stage 

The design stage is carried out to develop the initial concept of interactive PowerPoint 
learning media based on the analysis results. The material used is economic activities 
(production, distribution, consumption, and the role of economic actors) in accordance with 
the teacher's handbook and curriculum. The media is designed with interactive menus such 
as preliminary, content, discussion, conclusion, and quiz, equipped with text, video, 
animation, and hyperlinks between pages. In addition, validation instruments are developed, 
including assessment sheets for media experts, subject matter experts, teachers, and students 
to evaluate the feasibility and practicality of the product and provide input for its 
improvement. 
4.1.3. Development Stage 

At this stage, researchers create interactive PowerPoint learning media based on the 
results of analysis and design. The creation process includes collecting materials such as 
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images, animations, videos, and materials from relevant sources, then compiling them using 
PowerPoint version 2019 or higher with additional audio narration. Next, the media that has 
been created is validated by subject matter experts, media experts, and teachers to obtain 
feedback for improvement before being tested. 
4.1.3.1 Creating Interactive PowerPoint Media Templates 

Researchers created covers and main menus using shapes, images, and morph effects to 
make PowerPoint presentations more attractive and proportional. 
 

 
Figure 3. Interactive PowerPoint Media Templates 

 
4.1.3.2. Adjusting Object Rotation 

Object rotation is adjusted through the Shape Format menu by adding an oval shape and 
text box for the title, as well as a special area for the menu buttons to make the cover layout 
neater. 

 
Figure 4. Adjusting Object Rotation 

 
4.1.3.3. Adding Animated Images 

Animated images from the web are inserted into the template and positioned neatly and 
attractively, adjusting the size on each slide. 
 

 
Figure 5. Image Object Settings in the Menu Button 
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Figure 6. Image Objects on Each Slide After Opening 

 
To make the image move like an animation, select the object, open the Animations menu, 

then select the Lines effect and set the direction of movement as needed. 
 

 
Figure 7. Animation Setting Process 

 
4.1.3.4. Using Morph Transitions 

The next step is to add Morph transitions to make the presentation more interesting. This 
feature is available in PowerPoint 2019 and above based on Microsoft 365. 

 
Figure 8. Morph Transitions 

 
4.1.3.5. Creating Navigation Buttons 

PowerPoint is considered interactive if there is two-way interaction between the media 
and the user (Trimansyah, 2021). Navigation buttons such as back, next, home, and close are 
created using the Insert → Action → Hyperlink to feature according to their respective 
functions. 
 

 
Figure 9. Adding Hyperlinks and Sound Effects 

 
4.1.3.6. Incorporating Learning Materials 

The materials come from student books on economic activities, are tailored to learning 
outcomes, and are presented  in easy-to-understand language. 
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4.1.3.7. Inserting Voiceovers 
Voiceovers are inserted using the Insert → Audio → Record Audio feature in 

PowerPoint. After recording, set the audio playback on the Playback tab to Automatically or 
On Click, then repeat on each slide. 

 

 
Figure 10. Voiceover 

The audio is set through the Animation → Animation Pane menu, then adjusted 
according to the order in which the material appears. Set the Start With Previous option so 
that the audio plays automatically according to the session. 

 

 
Figure 11. Audio Playback Settings 

4.1.3.8. Creating Interactive Quizzes 
The final part of the media contains interactive multiple-choice quizzes with automatic 

feedback for correct and incorrect answers. The response animation is set using the trigger 
feature in the animation pane menu so that it appears according to the user's choice. 

 

 
Figure 12. Multiple Choice Answer Creation Process 

 
The use of triggers is combined with answers and feedback animations by selecting an 

animated image, then in the trigger menu, select on click of and determine the correct or 
incorrect answer according to the animation displayed. 
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Figure 13. Trigger Setting Process 

 
The trigger feature allows the media to display automatic feedback, so that users 

immediately know the correct or incorrect answer after answering the quiz. 
 
4.1.3.9. Media Validation 

The next stage of development is media validation by media experts, material experts, 
and learning experts. Data is obtained from questionnaires (quantitative) as well as criticism 
and suggestions from validators (qualitative). 
 
4.1.4. Implementation Stage 

The media was implemented in Grade X offline without the internet, with researchers 
observing that students appeared more focused and active. 

 

 
Figure 14. Students Paying Attention to the Teacher 

 

 
Figure 15. Students Active in Learning Discussions 

 
4.1.5. Evaluation Stage 

The evaluation was carried out by assessing the validity, effectiveness, and suggestions of 
the validators regarding the learning media. 
 
4.1.6. Paired Sample T-Test 

The Paired Sample T-Test was used to examine the differences in student activeness and 
learning outcomes before and after using interactive PowerPoint in the experimental class (X-
7) and the control class (X-6), after the data were tested for normality. 
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Table 1. Results of the Paired Sample T-Test 
for the Experimental Class of SMAN 1 Ngluar 

  Mean N 
Pair 1 Pretest Activeness 38,13 30 

 Posttest Activeness 64,00 30 
Pair 2 Pretest Learning Outcomes 38,00 30 

 Posttest Learning Outcomes 51,67 30 
Source: SPSS Output, processed by the researcher (2025) 

 
The results show an increase in activeness (pretest mean 38.13 → posttest 64.00) and 

learning outcomes (pretest mean 38.00 → posttest 51.67) after the use of interactive 
PowerPoint, with the posttest values being higher than the pretest. 
 

Table 2. Results of the Paired Sample T-Test 
for the Experimental Class of SMAN 1 Ngluar 

  Mean df Sig. (2.tailed) 
Pair 1 Pretest-Posttest Activeness -12,586 29 <0,001 
Pair 2 Pretest-Posttest Learning Outcomes -13,667 29 <0,001 

Source: SPSS Output, processed by the researcher (2025) 
 
The test results show a significant increase in activeness (mean -12.586, p = 0.001 < 0.05) 

and learning outcomes (mean -13.667, p = 0.001 < 0.05) after using interactive PowerPoint, 

so H₀ is rejected. The control class data are presented below. 
 

Table 3. Results of the Paired Sample T-Test for the Control Class of SMAN 1 Ngluar 
\  Mean N 

Pair 1 Pretest Activeness 39,47 30 
 Posttest Activeness 59,50 30 

Pair 2 Pretest Learning Outcomes 36,67 30 
 Posttest Learning Outcomes 47,33 30 

Source: SPSS Output, processed by the researcher (2025) 
 
The results show an increase in activeness (pretest mean 39.47 → posttest 59.50) and 

learning outcomes (pretest mean 36.67 → posttest 47.33) after using PowerPoint, with 
posttest values higher than pretest. 

 
Table 4. Results of the Paired Sample T-Test for the Control Class of SMAN 1 Ngluar 

  Mean df Sig. (2.tailed) 
Pair 1 Pretest-Pposttest Activeness -20,033 29 <0,001 
Pair 2 Pretest-Posttest Learning Outcomes -10,667 29 <0,003 

Source: SPSS Output, processed by the researcher (2025) 
 
The results show a significant increase in activeness (Δ mean = -12.586; sig. 0.001 < 0.05) 

and learning outcomes (Δ mean = -13.667; sig. 0.003 < 0.05) of students before and after 
using PowerPoint at SMA N 1 Ngluar. The experimental class data of SMA Muhammadiyah 
1 Muntilan are presented in the following table. 

 
Table 5. Results of the Paired Sample T-Test 

for the Experimental Class of SMA Muhammadiyah 1 Muntilan 
  Mean N 

Pair 1 Pretest Activeness 39,63 30 
 Posttest Activeness 66,27 30 

Pair 2 Pretest Learning Outcomes 36,67 30 
 Posttest Learning Outcomes 56,67 30 

Source: SPSS Output, processed by the researcher (2025) 
 
The results show an increase in activeness (pretest mean 39.63 → posttest 66.27) and 

learning outcomes (pretest mean 36.67 → posttest 56.67) after the use of interactive 
PowerPoint at SMA Muhammadiyah 1 Muntilan. 
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Table 6. Results of the Paired Sample T-Test 
for the Experimental Class of SMA Muhammadiyah 1 Muntilan 

  Mean df Sig. (2.tailed) 
Pair 1 Pretest-Pposttest Activeness -26,633 29 <0,001 
Pair 2 Pretest-Posttest Learning Outcomes -20,000 29 <0,001 

Source: SPSS Output, processed by the researcher (2025) 
 
The results show a significant increase in activeness (−26.633) and learning outcomes 

(−20.000) with sig. 0.001 < 0.05, so H₀ is rejected. This indicates a significant difference 
before and after the use of interactive PowerPoint at SMA Muhammadiyah 1 Muntilan. 

 
Table 7. Results of the Paired Sample T-Test 

for the Control Class of SMA Muhammadiyah 1 Muntilan 
  Mean N 

Pair 1 Pretest Activeness 41,70 30 
 Posttest Activeness 59,17 30 

Pair 2 Pretest Learning Outcomes 33,67 30 
 Posttest Learning Outcomes 45,67 30 

Source: SPSS Output, processed by the researcher (2025) 
 
The results show an increase in activeness (mean 41.70 → 59.17) and learning outcomes 

(mean 33.67 → 45.67) after using PowerPoint, with posttest values higher than pretest. 
 

Table 8. Results of the Paired Sample T-Test 
for the Control Class of SMA Muhammadiyah 1 Muntilan 

  Mean df Sig. (2.tailed) 
Pair 1 Pretest-Pposttest Activeness -17,467 29 <0,001 
Pair 2 Pretest-Posttest Learning Outcomes -12,000 29 <0,001 

Source: SPSS Output, processed by the researcher (2025) 
 
The test results show a significant increase in activeness (-17.467) and learning outcomes 

(-12.000) of students after using PowerPoint at SMA Muhammadiyah 1 Muntilan (p < 0.05). 
 

4.1.7. Independent Sample T-Test 
The Independent Sample T-Test was used to compare the experimental class (using 

interactive PowerPoint) with the control class (using regular PowerPoint) after the data were 
declared homogeneous. 

 
Table 9. Group Statistics Results for SMAN 1 Ngluar 

 Class N Mean 
Activeness Control Class 30 54,97 

 Experimental Class 30 64,00 
Learning Outcomes Control Class 30 47,33 

 Experimental Class 30 51,67 
Source: SPSS Output, processed by the researcher (2025) 

 
The participants of each class totaled 30. Activeness mean: control 54.97, experimental 

64.00. Learning outcomes mean: control 47.33, experimental 51.67. Next, the Independent 
Sample T-Test was conducted. 

 
Table 10. Independent Sample T-Test Results for SMA N 1 Ngluar 
  Sig.(2-tailed) Mean Difference 

Activeness Equal variances assumed 0,001 -9,033 
 Equal variances not assumed 0,001 -9,033 

Learning Outcomes Equal variances assumed 0,000 -12,333 
 Wqual variances not assumed 0,000 -12,333 

Source: SPSS Output, processed by the researcher (2025) 
 



 
 
 
 
 
International Journal of Economics, Commerce, and Management 2025, vol. 2, no. 4, Damayanti, et al. 220 of 222 

 

Activeness: sig. 0.001 < 0.05, mean difference -9.033. Learning outcomes: sig. 0.000 < 

0.05, mean difference -12.333. H₀ is rejected, meaning there is a significant difference between 
the control and experimental classes at SMA N 1 Ngluar. The data for SMA Muhammadiyah 
1 Muntilan are presented below. 
 

Table 11. Group Statistics Results for SMA Muhammadiyah 1 Muntilan 
 Class N Mean 

Activeness Control Class 30 41,70 
 Experimental Class 30 59,17 

Learning Outcomes Control Class 30 45,67 
 Experimental Class 30 56,67 

Source: SPSS Output, processed by the researcher (2025) 
 
Activeness: mean control 41.70, experimental 59.17. Learning outcomes: mean control 

45.67, experimental 56.67. The Independent Sample T-Test data for SMA Muhammadiyah 1 
Muntilan are presented below. 

 
Table 12. Independent Sample T-Test Results for SMA Muhammadiyah 1 Muntilan 

  Sig.(2-tailed) 
Mean 

Difference 
Activeness Equal variances assumed 0,000 -17,467 

 Equal variances not assumed 0,000 -17,467 
Learning Outcomes Equal variances assumed 0,000 -11,000 

 Wqual variances not assumed 0,000 -11,000 
Source: SPSS Output, processed by the researcher (2025) 

 
Activeness (sig. 0.000, Δmean -17.467) and learning outcomes (sig. 0.000, Δmean -11.000) 

show that H₀ is rejected; there is a significant difference between the control and experimental 
classes at SMA Muhammadiyah 1 Muntilan. 

 
4.1.8. N-Gain Score 

The results of the Paired Sample T-Test show a significant increase in student activeness 
and responsibility before and after using interactive PowerPoint at SMA N 1 Ngluar and SMA 
Muhammadiyah 1 Muntilan, with the N-Gain score indicating effectiveness in activeness and 
learning outcomes 

Table 13. Gain Score Effectiveness Test Results 

 Description SMA N 1 Ngluar 
SMA Muhammadiyah 1 

Muntilan 
Activeness Mean 0,42 0,44 

 Minimum 0,23 0,15 
 Maximum 0,58 0,59 

Learning Outcomes Mean 0,58 0,55 
 Minimum 0,43 0,33 
 Maximum 0,67 0,67 

Source: Excel Output, processed by the researcher (2025) 
 
The N-Gain results show that the activeness and learning outcomes of students at SMA 

N 1 Ngluar (0.42; 0.58) and SMA Muhammadiyah 1 Muntilan (0.44; 0.55) > 0.3, so the use 
of interactive PowerPoint is effective. 
 
4.1.9. Final Product Review 

This research developed an interactive PowerPoint based on ADDIE to improve 
student activeness and learning outcomes on economic activity material. The media 
contains material, images, videos, group assignments, and interactive quizzes, and has been 
validated by experts and tested on students with a very feasible score. 

The statistical test results (Paired and Independent Sample T-Test) show a significant 
increase in activeness and learning outcomes compared to before usage and the control class. 
The N-Gain shows the media is effective, with SMA N 1 Ngluar (0.415; 0.582) and SMA 
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Muhammadiyah 1 Muntilan (0.436; 0.551). The interactive PowerPoint is effective because it 
presents the material attractively, clearly, and encourages active student participation. 

5. Conclusion 

The interactive PowerPoint developed functions as audio-visual learning media designed 
to improve student activeness and learning outcomes with medium capacity, and has been 
validated with very feasible scores by material experts (4.6), media experts (4.8), practitioner 
teachers (4.6 and 4.3), and 40 students (4.5). Its effectiveness is indicated by an increase in 
activeness and learning outcomes at SMA N 1 Ngluar (N-Gain 0.415 and 0.582) and SMA 
Muhammadiyah 1 Muntilan (N-Gain 0.436 and 0.551), along with significant differences 
when compared to control classes, showing that the interactive PowerPoint can be used for 
economic activity material in both offline and online learning without requiring internet 
access. Future researchers are advised to develop the media more efficiently, test its influence 
on larger samples, socialize its use for wider adoption, and collaborate it with learning 
methods suited to student characteristics to produce newer findings. 

The interactive PowerPoint developed serves as audio-visual learning media aimed at 
increasing students’ activeness and learning outcomes with medium capacity, and it has been 
validated with very feasible scores by material experts, media experts, practitioner teachers, 
and students. Its effectiveness is shown through significant increases in activeness and 
learning outcomes in both SMA N 1 Ngluar and SMA Muhammadiyah 1 Muntilan compared 
to control classes, indicated by positive N-Gain values. This media can be utilized for teaching 
economic activity materials, applied in both offline and online learning, and accessed without 
an internet connection. For future development, researchers are advised to create more 
efficient versions of the media, examine its impact on a wider sample, socialize it for broader 
adoption, and collaborate it with learning methods that align with student characteristics to 
generate more updated findings. 
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